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How do I Reconcile MCPS Invoices? 

 Overview 
Purpose This document explains how schools can reconcile Montgomery County Public School 

(MCPS) invoices to requisitions charged to their cash account and to the related purchase 
order or sales order. In the Financial Management System (FMS), the requisition is posted to 
the MCPS invoice by line item instead of in summary format. This document also explains 
how to export transaction detail to a Microsoft Excel spreadsheet and sort and subtotal the 
detail in preparation for entry into the school’s financial software application. 

Recommended 
Prerequisite 

To more easily match MCPS invoices to supporting documentation, file printed copies of the 
supporting documentation in one of the following ways: 

 File the requisitions in a binder, making sure to write the purchase order number or sales 
order number on the requisition. 

 File the purchase orders in a binder and the sales orders in a separate binder. 

After all of the items on the invoice are delivered and the invoice is paid, you can discard the 
printed supporting documentation for that invoice. 

Changes to 
Invoices after 
the FMS 
Implementation 
in July 2007 

The following changes to invoices and supporting documentation will aid in the reconciliation 
procedure: 

Implemented beginning with October 2007 invoices: 
 Purchase order numbers for freight allocations (indicated by a series of Xs on the invoice) 

are on invoices. 

 The sales order number or purchase order number is on invoices. 

Implemented beginning with November 2007 invoices: 
 Descriptions on invoices are sorted and grouped by like descriptions. 

Click here to view a sample invoice with unsorted descriptions. 

Click here to view a sample invoice with sorted descriptions. 

 The requisition number is on sales orders. 

 The release number for blanket purchase orders is in line item descriptions. 

 Reconciliation Guidelines 

 During reconciliation, you verify that an invoice is OK to pay. If the invoice matches the 
supporting documentation, which includes the requisition plus either the sales order (for 
warehouse items) or purchase order (for items ordered directly from vendors), then it is OK 
to pay. The goal is to ensure that you are being billed for what you ordered. If you need 
additional details to match the invoice to the supporting documentation, you can perform a 
GL inquiry to search for these details. 

Also during reconciliation, you summarize transaction details to enter into the school’s 
financial software application. You can prepare this summary in FMS by performing an AR 
inquiry to export the transaction detail into a Microsoft Excel spreadsheet then sort and 
subtotal the exported detail. 
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Below are guidelines for the following reconciliation tasks: 

 Reconciling purchase order transactions 

 Reconciling warehouse transactions 

 Reconciling payroll transactions 

 Reconciling American Express transactions 

 Performing an AR inquiry to summarize and export transaction detail 

Reconciling 
Purchase Order 
Transactions 

To reconcile an invoice for items ordered directly from a vendor, you can match the invoice 
line by line to the printed copy of the purchase order or requisition, which you should 
maintain in a binder according to the recommended prerequisites indicated above. If you 
need additional details to match the invoice to the supporting documentation, as is generally 
the case with the receipt of partial orders from vendors, you can perform a GL inquiry to 
search for these details. You can even add any of these details to the Excel spreadsheet that 
you export to summarize transaction details for entering into the school’s financial software 
application. 

To verify receipt of an item on a purchase order, check with the person who requested the 
item, or perform a PO inquiry as indicated in the Financial Inquiry and Reporting User Guide 
that was distributed during training. 

 To perform a GL inquiry to view details of purchase order transactions: 

1. Log in to FMS to open the FMS E-Business Suite Home Page. 

 
FMS E-Business Suite Home Page 

2. In the left column of the home page in the responsibilities column, click MCPS GL 
Inquiry to display general ledger inquiry functions that you can perform in FMS. 
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Functions for GL inquiry 

3. Under Inquiry, click Account. The Account Inquiry form opens.  

 
Account Inquiry form 

4. Under Accounting Periods, click in the From field, then type or select the desired period 
for transactions charged to your cash account. For example, if the invoice date is 
October 2007, the entry for both fields would be SEP-08. 

NOTE: If you typed the period in the From field, after you click elsewhere on the form or 
press the Tab key to advance to another field, that same period is automatically entered 
in the To field. 

5. Under Accounts, click the blue box at the left of the first line. The Find Accounts dialog 
box opens. 

 
Find Accounts dialog box 

6. In the Find Accounts dialog box, type or select the department and school, and in the 
Account field, type 121005 (cash account). 

7. Click the OK button to close the dialog box and return to the Account Inquiry form. Under 
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Accounts, cash accounts for the selected period are displayed. 

 
Account Inquiry form showing cash accounts 

8. Click the desired cash account, then click the Show Balances button to show 
summarized details about that cash account on the Detail Balances form. 

 
Detail Balances form 

9. To view more detail about the cash account, such as the breakdown of the amounts 
debited and credited to the account, click the Journal Details button to open the 
Journals form. 



 

Reconciling MCPS Invoices (Continued) 

 

 5 
 

 
Journals form 

10. To view details about an invoice, such as invoice number, invoice date, supplier name, 
and purchase order number, click the line with the amount in the Entered Debit field that 
matches the line item on the invoice. 

NOTE: If there are many rows on the form, you can search for the desired amount by 
clicking F11, typing the amount in the Entered Debit field, then pressing Ctrl+F11. 

11. With the line item selected, click the Drilldown button. The Payables Invoice Accounting 
form opens. 

 
Payables Invoice Accounting form 

12. To view payment information, click the Show Transaction button to open the Invoices 
form, then click the View Payments tab. 
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Invoices form – View Payments tab 

13. To view how the payment was distributed to specific cash accounts, click the 
Distributions button to open the Distributions form. Information on the form is organized 
by purchase order line item. 

 
Distributions form 

Reconciling 
Warehouse 
Transactions 

Reconciling warehouse transactions is straightforward because the warehouse sends only 
complete shipments against sales orders, not partial shipments, and discrepancies in unit 
price do not have to be considered. Reconciliation is simply a matter of matching the details 
of the invoice to a copy of the sales order. In FMS, you can perform a GL inquiry and drill 
down to view sales order details, including the requisition number, which is not on MCPS 
invoices for July through October 2007. 

 To perform a GL inquiry to view details of warehouse transactions: 

1. In the section above, Reconciling Purchase Order Transactions, follow steps 1 through 9 
to open the Journals form. 
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Journals form 

2. To view details about warehouse transactions, click the line with the amount in the 
Entered Debit field that matches the line item on the invoice. 

NOTE: If there are many rows on the form, you can search for the desired amount by 
clicking F11, typing the amount in the Entered Debit field, then pressing Ctrl+F11. 

3. With the line item selected, click the Drilldown button. The Inventory Material 
Accounting form opens. 

 
Inventory Material Accounting form 

4. To view requisition information, click the Show Transaction button to open the Material 
Transactions form, then click the Transaction Type tab. 
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Requisition 
Number 

 
Material Transactions form – Transaction Type tab 

Reconciling 
Payroll 
Transactions 

Payroll information in FMS is at the summary level. Detailed information for employees is not 
stored in FMS. If you have not received your monthly detailed report of employee payroll 
charges, contact Deena St. Rose, MCPS Accounts Receivables Specialist, at 301-279-3766. 

Reconciling 
American 
Express 
Transactions 

To reconcile invoices to American Express charges, review your statement of activity from 
American Express. 

Performing an 
AR Inquiry to 
Summarize and 
Export 
Transaction 
Detail 

The following step-by-step instructions explain how to perform an AR inquiry to export 
transaction detail for an invoice to an Excel spreadsheet then sort and subtotal the detail in 
preparation for entry into your school’s financial software application. 

 To perform an AR inquiry to summarize and export transaction detail for an 
invoice: 

1. Log in to FMS to open the FMS E-Business Suite Home Page. 

 
E-Business Suite Home Page 

2. In the left column of the home page in the responsibilities column, click MCPS AR 
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Inquiry to display accounts receivables transactions inquiry functions that you can 
perform in FMS. 

 
Inquiry functions for AR transactions 

3. Under Transactions, click Transactions Summary. The Transactions Summary form 
opens. 

 
Transactions Summary form 

4. On the toolbar, click the Show Navigator button ( ) to open the Navigator. 

 
Navigator 

5. With the Navigator open, on the Tools menu, make sure that the Close Other Forms 
command is unchecked. 

6. Click the Transactions Summary form to bring it back into focus. 

7. On the Transactions Summary form, click the Open button to open the Transactions 
form. 
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Transactions form 

8. Search for the desired invoice by pressing F11, entering the invoice number in the 
Number field, and pressing Ctrl+F11 to retrieve search results. 

 
Transactions form showing search results 

9. Click the Line Items button. The Lines form opens showing details about each line item 
on the invoice. 
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Lines form 

NOTE: For August through October 2007 invoices, the descriptions are not sorted and 
grouped by like descriptions. You can sort and group the descriptions after exporting to 
an Excel spreadsheet, as explained in the next set of step-by-step instructions. 
However, beginning with November 2007 invoices, descriptions are sorted and grouped 
by like descriptions. 

 To export transaction detail for an invoice to an Excel spreadsheet: 

1. With the Lines form open and the cursor anywhere in the detail section of the form, on 
the File menu, press and hold the Ctrl key and click Export. The File Download dialog 
box opens prompting you to save the file in preparation for exporting. 

 
File Download dialog box 

NOTE: If the cursor is in the header section of the form, only the information in the 
header will export. Sometimes transaction detail will export correctly without your having 
to press and hold the Ctrl key when clicking Export, but it is best to do so anyway. 

2. On the dialog box, click the Save button. The Save As dialog box opens. 

Header 

Detail 
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Save As dialog box 

3. Navigate to where you want to save the exported file—the Desktop or your own personal 
folder, changing the name of the file if desired. 

4. Open Microsoft Excel. 

5. In Excel, on the File menu, click Open. The Open dialog box is displayed. 

 
Open dialog box 

6. Navigate to the exported file, changing the entry in the File of type field to All Files. 

7. Double-click on the name of the exported file to open step 1 of the Text Import Wizard. 

 
Text Import Wizard – Step 1 of 3 

8. On the wizard under Original data type, make sure that the Delimited option is selected. 

9. Click the Next button to advance to step 2 of the wizard. 
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Double-
click line 
to expand 
column 

Select All 
button 

 
Text Import Wizard – Step 2 of 3 

10. For step 2, leave the settings as is, and click the Next button to advance to step 3. 

 
Text Import Wizard – Step 3 of 3 

11. For step 3, leave the settings as is, and click the Finish button. The exported file opens. 

 
Exported file 

12. To expand a column’s width, double-click on the line to the right of the column letter. For 
example, to expand column C, double-click the line to right of the letter “C.” 

13. To sort by like descriptions if necessary, do the following: 

 Click the Select All button. 
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 On the Data menu, click Sort to open the Sort dialog box. 

 
Sort dialog box 

 Under Sort by, click the down arrow to display options, then click to select 
Description. 

 Also under Sort by, click the Descending option. 

 Click the OK button to perform the chosen sort. 

14. After the spreadsheet is sorted by like descriptions, do the following to calculate 
subtotals and a grand total for the values in the Amount column: 

 Insert a blank row at each change in description in preparation for calculating 
subtotals for like descriptions. For example, insert a blank row after a group of 
descriptions beginning with the following: 

 Pay Period 

 INV: 

 AP: 

 AMEX 

 For the Amount cell in each blank row that you added, in the formula bar, insert a 
formula similar to the one below, specifying the appropriate range for your 
spreadsheet. Then press the Enter key to display the subtotal. 

=SUBTOTAL(9,G4:G10), where 9 means to add the values in the Amount column 
specified by the range G4:G10. G4:G10 means column G, rows 4 through 10. 

 
Sorted rows with subtotals 

 To calculate a grand total, with the cursor in the blank Amount cell after the last 
subtotal, on the toolbar, click the AutoSum button ( ). Then press the Enter key to 
display the total of all of the subtotals. 

15. If desired, add other information to the spreadsheet that would be helpful when entering 
transaction details into the school’s financial software application, such as agency 
account number or units ordered. 

16. On the toolbar, click the Save button ( ). 

Formula Bar 
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Sample Invoice with Unsorted Descriptions 
 

 
Sample invoice with unsorted descriptions (page 1 of 3) 
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Sample invoice with unsorted descriptions (page 2 of 3) 
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Sample invoice with unsorted descriptions (page 3 of 3) 



 

Reconciling MCPS Invoices (Continued) 

 

 18 
 

Sample Invoice with Sorted Descriptions 
 

 
Sample invoice with sorted descriptions (page 1 of 3) 
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Sample invoice with sorted descriptions (page 2 of 3) 
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Sample invoice with sorted descriptions (page 3 of 3) 


